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Foreword  

Thank you for purchasing VT-AGV-3588J AGV controller (“the Device” or “the Product”). This 
manual intends to provide guidance and assistance necessary on setting up, operating or 
maintaining the Product. Please read this manual and make sure you understand the structure 
and functionality of the Product before putting it into use. 

Intended Users 

This manual is intended for: 

• Operator of the Product 

• Technical support engineers 

• Other users 

Copyright 

Vantron Technology, Inc. (“Vantron”) reserves all rights of this manual, including the right to 
change the content, form, product features, and specifications contained herein at any time 
without prior notice. An up-to-date version of this manual is available at 
www.vantrontech.com.  

The trademarks in this manual, registered or not, are properties of their respective owners. 
Under no circumstances shall any part of this user manual be copied, reproduced, translated, 
or sold. This manual is not intended to be altered or used for other purposes unless otherwise 
permitted in writing by Vantron. Vantron reserves the right of all publicly released copies of 
this manual. 

Disclaimer 

While all information contained herein has been carefully checked to assure its accuracy in 
technical details and typography, Vantron does not assume any responsibility resulting from 
any error or features of this manual, nor from improper uses of this manual or the software.  

It is our practice to change part numbers when published ratings or features are changed, or 
when significant construction changes are made. However, some specifications of the Product 
may be changed without notice. 
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Technical Support and Assistance 

Should you have any question about the Product that is not covered in this manual, contact 
your sales representative for solution. Please contain the following information in your 
question: 

• Product name and PO number; 

• Complete description of the problem; 

• Error message you received, if any. 

 

Vantron Technology, Inc.  

Address: 48434 Milmont Drive, Fremont, CA 94538  

Tel: (650) 422-3128  

Email: sales@vantrontech.com 

 

Regulatory Information 

The Product is designed to comply with: 

• FCC 

Please refer to the Appendix for Regulatory Compliance Statement. 

 

Symbology  

This manual uses the following signs to prompt users to pay special attention to relevant 
information. 

 Caution for latent damage to system or harm to personnel  

 Attention to important information or regulations 
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General Safety Instructions  

The Product is supposed be installed by knowledgeable, skilled persons familiar with local 
and/or international electrical codes and regulations. For your safety and prevention of 
damage to the Product and other equipment connected to it, please read and observe 
carefully the following safety instructions prior to installation and operation. Keep this manual 
well for future reference.  

• Do not disassemble or otherwise modify the Product. Such action may cause heat 
generation, ignition, electronic shock, or other damages including human injury, and may 
void your warranty.  

• Keep the Product away from heat source, such as heater, heat dissipater, or engine casing. 

• Do not insert foreign materials into any opening of the Product as it may cause the 
Product to malfunction or burn out.   

• To ensure proper functioning and prevent overheating of the Product, do not cover or 
block the ventilation holes of the Product. 

• Follow the installation instructions with the installation tools provided or recommended. 

• The use or placement of the operation tools shall comply with the code of practice of 
such tools to avoid short circuit of the Product. 

• Cut off the power before inspection of the Product to avoid human injury or product 
damage. 
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Precautions for Power Cables and Accessories 

Use proper power source only. Make sure the supply voltage falls within the specified 
range. The Product is designed to use 9-36V DC. Always check whether the Product is DC 
powered before applying power.  

Place the cables properly at places without extrusion hazards. 

Use only approved antenna(s). Non-approved antenna(s) may produce spurious or 
excessive RF transmitting power which may violate FCC limits. 

Cleaning instructions:  

• Power off before cleaning the Product 

• Do not use spray detergent 

• Clean with a damp cloth 

• Do not try to clean exposed electronic components unless with a dust collector 

Power off and contact Vantron technical support engineer in case of the following faults: 

• The Product is damaged 

• The temperature is excessively high 

• Fault is still not solved after troubleshooting according to this manual 

Do not use in combustible and explosive environment: 

• Keep away from combustible and explosive environment 

• Keep away from all energized circuits 

• Unauthorized removal of the enclosure from the device is not allowed 

• Do not replace components unless the power cable is unplugged 

• In some cases, the device may still have residual voltage even if the power cable is 
unplugged. Therefore, it is a must to remove and fully discharge the device before 
replacement of the components. 
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 CHAPTER 1 PRODUCT INTRODUCTION 
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1.1 Terminologies and Acronyms 

Below is a summary of the key terminologies and acronyms that will be covered in this 
manual. 

Glossary Description 

AGV Automated guided vehicle 

I/O Input / output 

AI Analog input 

AO Analog output 

DI Digital input 

DO Digital output 

CAN Controller Area Network 

TX Data transmission 

RX Data reception 

DAC Digital-analog converter 

M12 connector A  metric circular connector with a 12mm locking thread interface 

CODESYS 

Controlled Development System (Codesys) is a comprehensive 
environment that includes both the development environment (IDE 
– Integrated Development Environment) and the runtime 
environment. It supports a wide array of programming languages, 
allowing developers to use preferred tools with greater flexibility. 

ROS  

Robot Operating System (ROS) is a set of software libraries and tools 
for building robot applications. It provides the services you would 
expect from an operating system, including drivers to state-of-the-
art algorithms, and with powerful developer tools. 
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1.2 Overview 

VT-AGV-3588J AGV controller is dedicated for the Automated Guided Vehicle (AGV) and 
Autonomous Mobile Robot (AMR) industries, boasting outstanding performance and 
powerful functions for the automation of vehicles, such as standard lift trucks and mobile 
robots. It comes with a 16GB memory and 128GB storage, with option for larger capacity 
configurations, easily handling complex computations and large-scale data storage 
requirements. Equipped with an STM32 series MCU, it provides a reliable control 
foundation for the entire system, enabling rapid and accurate data processing and 
instruction execution.  

VT-AGV-3588J features three Gigabit Ethernet ports (M12 aviation plugs), dual-band 
(2.4GHz&5GHz) Wi-Fi, and Bluetooth 5.4, ensuring stable network communication to 
meet the rapid data transfer needs. The full-function USB Type-C interface supports OTG 
and DP output for convenient operation and monitoring. In addition, the controller offers 
rich interfaces for connection of various peripherals, including USB Type-A, CAN 2.0, DI, 
DO, AI, AO, isolated RS232, RS485, and SSI, ensuring efficient and stable operation of 
AGVs. 

 VT-AGV-3588J runs on the ubuntu 22.04 operating system, with flexible integration of 
Codesys Runtime and ROS 2 Humble, which enables customers to develop AGV/AMR 
control solutions for different application scenarios according to their specific needs, 
achieving more function expansions. 

1.3 Product Features 

• Arm-based Octa-core processor 

• 6 TOPS NPU for AI acceleration 

• AI/AO/DI/DO for industrial data automation 

• Wi-Fi/BT/ETH for network connectivity 

• USB, RS32/RS485/SSI, and CAN bus support for flexible system integration options 

• CANOpen, EtherCAT supported 

• Low-latency, low-jitter motion control 

• 9V-36V wide input voltage range 

• IP65-rated for demanding environments 

• Ubuntu 22.04 + CODESYS Runtime & ROS 2 Humble 
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1.4 Unpacking 

The Product has been carefully packed with special attention to quality. However, should 
you find any component damaged or missing, please contact your sales representative in 
due time. 

Standard accessories: 

• 1 x VT- AGV-3588J AGV Controller 

• 2 x Wi-Fi and Bluetooth antenna 

  Actual accessories might vary slightly from the list above as the customer order 
might be different from the standard configuration options. 

 

1.5 Mechanical Dimensions 

• 239.9mm x 124.9mm x 54.5mm   
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1.6 Specifications  

VT-AGV-3588J 

System 

CPU 
Quad-core ARM Cortex-A76 MPCore processor (Max. 2.0GHz) + Quad-core 

ARM Cortex-A55 MPCore processor (Max. 1.7GHz) 

GPU 
ARM Mali-G610 MC4, OpenGL ES 1.1/2.0/3.2, OpenCL 2.2, and Vulkan1.2 

supported 

NPU 6 TOPS, INT4/INT8/INT16/FP16 supported 

Memory 8GB LPDDR4 (Optional: 16GB) 

Storage 64GB eMMC V5.1 (Optional: 128GB) 

Communication 
Ethernet 3 x M12, 1000Mbps 

Wi-Fi & Bluetooth Wi-Fi IEEE 802.11 a/b/g/n/ac + BT 5.4 

Media 
Video processing  8K@60fps H.265 / 8K@30fps H.264 decoder, 8K@30fps H.265/H.264 encoder 

Display 1 x DisplayPort 1.4a combo with USB 3.0 Type-C 

I/O 

USB 2 x USB 2.0 Host 1 x USB 3.0 Type-C (OTG, DP) 

Serial port 
2 x RS232, isolated (Max. 235kbps) 2 x RS485, isolated (Max.500kbps) 

2 x SSI, isolated (Max. 10mbps) 

CAN 2 x CAN 2.0 

Analog input 4 x AI, isolated (2 x 0-20mA, 2 x 0-24V) 

Analog output 2 x AO, isolated (0-20mA) 

Digital input 12 x DI, isolated (0-24V at 50mA) 

Digital output 12 x DO, isolated (0-24V at 0.5A) 

Relay 2 x All_Ok relay output 

Antenna 2 x SMA male antenna connector for Wi-Fi and Bluetooth (distance: 3cm) 

Miscellaneous 
RTC Supported 

Watchdog timer Supported 

System Control 

Button 1 x User button (user definable) 

LED indicator 

1 x Power indicator 3 x ETH connectivity indicator 

1 x Error indicator for Codesys 1 x Wi-Fi connectivity indicator 

1 x Codesys running status indicator (Green: Normal operation; Red: Stopped) 

Power 
Input 9V-36V DC (over-voltage / power failure protection, reverse polarity protection) 

Consumption ~6W (Power on without applications running) 

Software 
OS Ubuntu 22.04 + Codesys Runtime & ROS 2 Humble 

Protocol CANOpen, EtherCAT 

Mechanical 

Dimensions 239.9mm x 124.9mm x 54.5mm  

Weight 960g 

Installation 4 x M5-16mm screw recommended  

IP rating IP65 

Environmental 

condition 

Temperature Operating: -20℃~70℃ Storage: -40℃ ~ +80℃ 

Humidity 5%~95% RH (non-condensing) 

 
  

http://www.vantrontech.com/


Vantron| Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 

 Vantron  | Public                    10            www.vantrontech.com 

VT-AGV-3588J 
User Manual 

1.7 Product Layout     

 
 

 

 
 
 
 
 
 
 
 
 
 

No. Description 

1 3 x M12 Ethernet port, 1000Mbps  (refer to the pinout in section 3.1) 

2 7 x LED indicator (refer to the LED definitions in section 3.5)  

3 Connector A (refer to the pinout in section 3.2) 

4 Connector B (refer to the pinout in section 3.3) 

5 User button (user definable) 

6 Full-featured USB 3.0 Type-C, supporting OTG, DisplayPort, programming 

7 2 x Wi-Fi and Bluetooth antenna 

 
 

  

1 2 3 

6 

7 
4 5 
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1.8 Operating System 

The device supports Ubuntu 22.04 operating system, with flexible integration of CODESYS 
Runtime and  ROS  2 Humble for customized development. 

1.9 Power Supply and Consumption 

VT-AGV-3588J works with 9V~36V DC power input supplied by the power pins included in 
connector A.  

The device consumes approximately 6W in an idle state (powered on but without active 
applications). Note that power consumption may vary significantly based on storage 
capacity, connected peripherals, operating system configuration, and other 
hardware/software settings. 

1.10 Environmental & Mechanical Specifications 

VT-AGV-3588J operates within a temperature ranging from -20℃ to +70℃ and at a 
relative humidity between 5% and 95% for non-condensing purpose. It is designed to be 
stored at a temperature range of -40℃ to +80℃. 

 

Parameter Description 

Ingress Protection IP65 

Weight 960g 

Antenna Connector SMA male 
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CHAPTER 2 GETTING STARTED 
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2.1 Device Installation 

Follow the steps below to finish hardware connection. 

1. Prepare four M5-16mm hexagon socket head screws.  

 

 

 

2. Parameters for the screw holes are as follows: 

• Device-side through hole:  

ο Diameter: 6mm 

ο Depth: 8mm 

• Mounting surface threaded hole: 

ο Recommended thread size: M5 × 0.8mm (coarse thread) 

ο Recommended depth: 9mm-10mm 

3. Use a 5.0mm drill bit for the M5 threads and make sure the hole depth is about 9mm-
10mm. 

4. Insert the screws through the device-side holes, then tighten the screws to make 
sure the device is securely fastened on the mounting surface. 
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2.2 Wiring the Device 

Once the device has been installed, adhere to the instructions provided below to wire the 
device as needed for subsequent use. 

1. Install the two provided Wi-Fi and Bluetooth antennas to the antenna connectors, and
hand tighten the antennas clockwise until they snug.

2. Connect one of the device's M12 Ethernet ports to a switch using an M12 X-coded (8-
pin) male-to-RJ45 cable (NET 0 is configured with a static IP address
(192.168.17.253/24) by default. To avoid conflicts, do not use this port for switch
connections).

3. Remove the USB Type-C cover, and use a USB Type-C to Type-C cable with display support 
to connect the device to a monitor for optimal performance.
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4. Prepare a DC power connector with wires crimped into insulated female butt splices. 

 

 

 

 

 

5. Insert the red wire (+) of the DC power connector into the power input pin, and the 
black wire (-) into the ground pin on the connector A of the device. 

 

 
 
 
 
 

 

 

 

 

6. Connect the DC power connector with a power adapter that supports 9V-36V power 
input, then plug the power adapter into an outlet to power up the device. 

 

 

 

 

 

 

  

Power input (B+) 

Ground  
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CHAPTER 3 HARWARE DESCRIPTION  
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This section briefs on the hardware definition and connector/jumper pinout. 

3.1 Ethernet 

VT-AGV-3588J offers three X-Coded M12 female Ethernet connectors, supporting up to 
1000Mbps transfer rate. NET 0 is configured with a static IP address (192.168.17.253/24) 
by default. 

 

 

 

 

Pinout description: 

Pin Wire Color Signal 

1 White + Orange D1 + 

2 Orange D1 - 

3 White + Green D2 + 

4 Green D2 - 

5 White + Brown D4 + 

6 Brown D4 - 

7 White + Blue D3 + 

8 Blue D3 - 

3.2 Connector A 

VT-AGV-3588J offers two 35-pin connectors, connector A and connector B. 

Connector A offers signals including RS232/485, AI, AO, CAN, USB 2.0, all OK (relay output), 
and power supply. 

 

Connector A Profile 
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Pinout description: 

Pin Signal Description 

1 P_GND Power ground 

2 RS232_RX0 RS232 receive (Channel 0) 

3 RS232_RX1 RS232 receive (Channel 1) 

4 RS232_TX1 RS232 transmit (Channel 1) 

5 RS485_A0 RS485 A (Channel 0) 

6 RS485_B0 RS485 B (Channel 0) 

7 RS485_B1 RS485_1 B 

8 RS485_A1 RS485_1 A 

9 DAC_GND DAC analog output ground 

10 AO_OUT2 
DAC analog output 

 (Channel 2, 4–20mA) 

11 AO_OUT1 
DAC analog output 

 (Channel 1, 4–20mA) 

12 ALL OK_CO 
Self-test OK output 

 (short connect CO & NO) 

13 GND_ISO_232 RS232 ground signal 

14 RS232_TX0 RS232 transmit (Channel 0) 

15 CAN0_L CAN0 L  

16 CAN0_H CAN0 H  

17 GND_ISO_485 RS485 signal ground 

18 USB20_CONN_2_DP USB2.0-2 DP host only 

19 USB20_CONN_2_DM USB2.0-2 DM host only 

20 GND Digital ground 

21 AI_V1 ADC analog input (0-24V, Channel 1) 

22 AI_A0 ADC analog input (0-20mA, Channel 0) 

23 AGND  ADC analog ground 

24 B+ Power input (+) (9V-36V, Typ. 24V) 

25 CAN1_H CAN1 H 

26 CAN1_L CAN1 L 

27 CAN_GND CAN ground 

28 GND Digital ground 
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Pin Signal Description 

29 USB20_CONN_1_DP USB2.0-1 DP host only 

30 USB20_CONN_1_DM USB2.0-1 DM host only 

31 VBUS5V0_USB20 USB2.0 5V VBUS 

32 VBUS5V0_USB20 USB2.0 5V VBUS 

33 AI_V0 ADC analog input 
 (0–24V, Channel 0) 

34 AI_A1 ADC analog input  
(0-20mA, Channel 1) 

35 ALL OK_NO Self-test OK output  
(short connect CO & NO) 

3.3 Connector B 

Connector B offers signals including SSI, DI, and DO. 

 

Connector B profile 

 

Pinout description: 

Pin Signal Description 

1 D_IN10 Digital input (Channel 10) 

2 D_IN11 Digital input (Channel 11) 

3 D_IN8 Digital input (Channel 8) 

4 D_IN7 Digital input (Channel 7) 

5 D_IN12 Digital input (Channel 12) 

6 DGND Digital input ground 

7 D_OUT1 Digital output (Channel 1) 

8 D_OUT2 Digital output (Channel 2) 

9 D_OUT3 Digital output (Channel 3) 

10 D_OUT4 Digital output (Channel 4) 
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Pin Signal Description 

11 D_OUT5 Digital output (Channel 5) 

12 D_OUT6 Digital output (Channel 6) 

13 D_IN9 Digital input (Channel 9) 

14 D_IN6 Digital input (Channel 6) 

15 D_IN5 Digital input (Channel 5) 

16 ISO_GND SSI ground 

17 CLK1+ SSI_1 differential clock + 

18 CLK1- SSI_1 differential clock - 

19 D_OUT7 Digital output (Channel 7) 

20 D_OUT9 Digital output (Channel 9) 

21 EX_GND Digital output ground 

22 D_OUT8 Digital output (Channel 8) 

23 D_OUT10 Digital output (Channel 10) 

24 D_IN1 Digital input (Channel 1) 

25 D_IN2 Digital input (Channel 2) 

26 D_IN3 Digital input (Channel 3) 

27 D_IN4 Digital input (Channel 4) 

28 DATA0+ SSSI_0 differential data+ 

29 DATA0- SSI_0 differential data- 

30 CLK0- SSI_0 differential clock - 

31 CLK0+ SSI_0 differential clock + 

32 DATA1- SSI_1 differential data - 

33 DATA1+ SSI_1 differential data + 

34 D_OUT11 Digital output (Channel 11) 

35 D_OUT12 Digital output (Channel 12) 
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3.4 Recommended Connector Cable  

You can use a 35-pin female D-SUB connector cable to interface with connector A or 
connector B. For custom wiring configurations, you can use standalone adapter wires with 
one end terminated in insulated female butt splices.  

The following reference diagram illustrates the specifications of a recommended 35-pin 
D-SUB connector cable for the connection. 

 

 

3.5 LED Indicators 

The definition of the LED indicators is set out as follows. 

LED Description 

NET 0 / NET 1 / NET 2 Blinks when there is active network communication via the 
corresponding Ethernet port. (NET 0 / NET 1 / NET 2) 

WLAN Blinks when a Wi-Fi connection is established. 

ERR Turns red upon system fault detection in CODESYS Runtime. 
(user configurable in ROS)  

RUN Device status indication in CODESYS Runtime: red for stop and 
green for normal operation. (user configurable in ROS) 

PWR Illuminates when the device is powered up.  
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3.6 Electrical Parameters 

This section details the critical electrical specifications and interface requirements for safe 
and optimal device operation, ensuring compatibility with industrial power systems and 
peripheral devices. 

3.6.1 Absolute Maximum Ratings 

Stresses beyond those listed under absolute maximum ratings may cause permanent 
damage to the device. 

Parameter Min. Typ. Max. Unit 

B+ Signal (Power input) 9 24 36 V 
Output Voltage GND  B+ V 

Input Voltage GND  B+ V 

Operational Temperature -20  70 ℃ 

Storage Temperature -40  80 ℃ 

 

3.6.2 CAN 

Parameter Min. Typ. Max. Unit 

CAN H/L voltage -2  7 V 

CAN H/L baud rate 80 500 5000 kbps 

CAN H/L positive going 
input threshold 

  900 mV 

CAN H/L negative going 
input threshold 

500   mV 

CAN H/L input resistance 9 15 28 kΩ 

Power consumption   400 mW 
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3.6.3 RS485 

Parameter Min. Typ. Max. Unit 

Signaling rate   500 Kbps 

Differential load resistance 54   Ω 

Output current, driver -60  60 mA 

Output current, receiver -8  8 mA 

High-level input voltage 
(Driver, driver enable, and 

receiver enable inputs) 
2  5.5 V 

Low-level input voltage 
(Driver, driver enable, and 

receiver enable inputs) 
0  0.8 V 

 

3.6.4 RS232 

Parameter Min. Typ. Max. Unit 

RS232 TX high level output 
voltage 

2.7 3.2  V 

RS232 TX low level output 
voltage 

  0.4 V 

RS232 RX positive going input 
threshold 

0.6 1.2  V 

RS232 RX negative going 
input threshold 

 1.5 2.4 V 

RS232 RX input resistance 3 5 7 kΩ 

RS232 baud rate  115200 235000 bps 

 

3.6.5 Digital Output 

Condition Typical 

24V power input 0~24V, 500mA 
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VT-AGV-3588J operates on Ubuntu 22.04 operating system with flexible integration of 
CODESYS Runtime and ROS  2 Humble for custom development.  

This chapter is mainly about the interface debugging and functionality testing. For 
interactive operation, you can: 

• Connect a monitor via the USB Type-C (DisplayPort Alt Mode) port. 

• Connect a keyboard and mouse to the USB 2.0 pins on connector A (refer to section 
3.2 for the pinout) 

4.1 System Settings 

4.1.1 User Login 

The system will automatically log in to linaro as the default user after boot.  

° User: linaro 

° Password: linaro 

These credentials are also valid for SSH login. 

4.1.2 SSH Login 

Follow these steps for SSH login via Ethernet to debug the device: 

1. Connect VT-AGV-3588J’s NET 0 Ethernet port to a host computer using an M12 X-
coded (8-pin) male-to-RJ45 cable. 

2. Manually assign an IP address to the host computer’s Ethernet interface, ensuring it 
is in the same subnet as VT-AGV-3588J. 

• Device (NET 0) IP: 192.168.17.253/24 (Default static IP) 

• Example Host IP: 192.168.17.100/24 

3. Open an SSH client utility on the host computer and log in to the device using 
credentials below. 

IP address: 192.168.17.253 

Username: linaro 

Password: linaro 
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4.1.3 EEPROM 

1. Create EEPROM Symlink. 

# ln -s /sys/bus/i2c/devices/6-0050/eeprom /dev/eeprom 

2. Read device serial number. 

# vtvdm -r sn 

3. Read device MAC address. 

# vtvdm -r mac 

4.1.4 Time Zone Setup 

1. Access the interactive time zone menu. 

# tzselect 

2. Follow the on-screen prompts to select the continent, country/region, and city (for 
instance: Detroit in the US). 

3. Copy the time zone file to the local time directory (/etc/localtime) to apply the time 
zone settings. 

# cp /usr/share/zoneinfo/America/Detroit /etc/localtime 

4. Display the active time zone and current time information. 

# date -R 

4.1.5 RTC 

Real-Time Clock (RTC) is an onboard hardware component that maintains time and date 
independently of the operating system. Correct RTC synchronization ensures consistent 
timekeeping across system reboots and power cycles. 

1. Update the software system clock (replace with desired date/time). 

# date -s "2025-08-01 22:01:00"     // Format: YYYY-MM-DD HH:MM:SS 

2. Write the current system time to the hardware RTC. 

# hwclock -w 

3. Power off the device for about 2 minutes. 

4. Power on the device and proceed to the next step. 

5. Read the RTC time information. 

# hwclock -r                                    // The time should be later than that set in step 1 
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4.1.6 Watchdog Timer 

The watchdog timer (WDT) is a hardware-based fail-safe mechanism that reboots the 
system if software fails to periodically "feed" it (indicating system hangs or critical failures). 
The WDT is disabled by default. Once enabled, the timeout is 7.8 seconds, meaning that 
the device must receive "feed" signals within this interval. If not, the system will reboot 
upon timeout, indicating a system or application failure.  

1. Enable the watchdog. 

# echo 1 > /sys/class/leds/wdt_set/brightness 

2. Feed the watchdog within the feeding intervals. 

# echo 1 > /dev/watchdog 

The command in step 2 must repeat at least once in every <7.8 seconds. Failure to feed will 
trigger hardware reboot or kernel warnings in system logs. 

 

4.1.7 Static Ethernet IP Setup   

After connecting the device to an active Ethernet network (via NET1 or NET2), you may 
configure a static IP address for the corresponding interface when required. 

By default, the NET0 interface has already been configured with a static IP address: 
192.168.17.253/24. 

Physical Ethernet ports NET 0, NET 1, and NET 2 correspond to net0, net1, and net2, 
respectively in the software system. 

Steps for setting up a static IP address for NET1: 

1. Open the Netplan configuration file. 

# vim /etc/netplan/01-network-manager-all.yaml  

2. Configure static IP for the desired interface using NetworkManager. 

network: 

    version: 2 

    renderer: NetworkManager 

    ethernets: 

      net1: 

        addresses: 

        - 192.168.17.259/24 
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4.2 Communication 

This section validates the core communication capabilities of the device through 
comprehensive testing of its network interfaces. 

4.2.1 Ethernet 

Physical Ethernet ports NET0, NET1, and NET2 correspond to net0, net1, and net2 in the 
software system. 

1. When needed, connect the device to an active Ethernet network via  NET1 or NET2. 

2. Check  the network interface information. 

# ifconfig  

 docker0: flags=4099<UP,BROADCAST,MULTICAST>  mtu 1500 

         inet 172.17.0.1  netmask 255.255.0.0  broadcast 172.17.255.255 

         ether 02:42:b7:37:06:d6  txqueuelen 0  (Ethernet) 

         RX packets 0  bytes 0 (0.0 B) 

         RX errors 0  dropped 0  overruns 0  frame 0 

         TX packets 0  bytes 0 (0.0 B) 

         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

  

 lo: flags=73<UP,LOOPBACK,RUNNING>  mtu 65536 

         inet 127.0.0.1  netmask 255.0.0.0 

         inet6 ::1  prefixlen 128  scopeid 0x10<host> 

         loop  txqueuelen 1000  (Local Loopback) 

         RX packets 160  bytes 13996 (13.9 KB) 

         RX errors 0  dropped 0  overruns 0  frame 0 

         TX packets 160  bytes 13996 (13.9 KB) 

         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

  

 net0: flags=4163<UP,BROADCAST,RUNNING,MULTICAST>  mtu 1500 

         inet 192.168.17.253  netmask 255.255.255.0  broadcast 192.168.17.255 

         inet6 fe80::78a5:98ff:fe3e:d183  prefixlen 64  scopeid 0x20<link> 

         ether 7a:a5:98:3e:d1:83  txqueuelen 1000  (Ethernet) 
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         RX packets 5  bytes 405 (405.0 B) 

         RX errors 0  dropped 1  overruns 0  frame 0 

         TX packets 10  bytes 970 (970.0 B) 

         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

  

 net1: flags=4099<UP,BROADCAST,MULTICAST>  mtu 1500 

         ether 18:9b:15:a5:12:12  txqueuelen 1000  (Ethernet) 

         RX packets 0  bytes 0 (0.0 B) 

         RX errors 0  dropped 0  overruns 0  frame 0 

         TX packets 0  bytes 0 (0.0 B) 

         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

  

 net2: flags=4099<UP,BROADCAST,MULTICAST>  mtu 1500 

         ether 18:9b:15:a5:12:11  txqueuelen 1000  (Ethernet) 

         RX packets 0  bytes 0 (0.0 B) 

         RX errors 0  dropped 0  overruns 0  frame 0 

         TX packets 0  bytes 0 (0.0 B) 

         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

         device interrupt 82   

  

 wlan0: flags=4099<UP,BROADCAST,MULTICAST>  mtu 1500 

         ether 58:02:05:b6:53:09  txqueuelen 1000  (Ethernet) 

         RX packets 0  bytes 0 (0.0 B) 

         RX errors 0  dropped 0  overruns 0  frame 0 

         TX packets 0  bytes 0 (0.0 B) 

         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

  

 wlan1: flags=4099<UP,BROADCAST,MULTICAST>  mtu 1500 

         ether 5a:02:05:16:53:09  txqueuelen 1000  (Ethernet) 

         RX packets 0  bytes 0 (0.0 B) 

         RX errors 0  dropped 0  overruns 0  frame 0 

         TX packets 0  bytes 0 (0.0 B) 
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         TX errors 0  dropped 0 overruns 0  carrier 0  collisions 0 

 

Software network interfaces net0~2 correspond to physical Ethernet ports NET 0~2.  

 net0 has been configured with a default static IP address: 192.168.17.253/24. 

wlan0 is the Wi-Fi client interface, and wlan1 is the Wi-Fi AP interface. 

 

4.2.2 Wi-Fi 

You can configure Wi-Fi either by using the Network icon on the taskbar of the device GUI 
or by using NetworkManager’s command-line tool (nmcli). 

Wi-Fi Client Mode 

Using NetworkManager’s command-line tool: 

1. Turn off the Wi-Fi feature. 

# nmcli r wifi off 

2. Turn on the Wi-Fi feature. 

# nmcli r wifi on 

3. Scan for available Wi-Fi SSIDs. 

# nmcli dev wifi list 

4. Connect to an existing SSID. 

# nmcli dev wifi connect <ssid> password <password> ifname wlan0 

5. Check the Wi-Fi connection status. 

# nmcli dev status 

6. Disconnect the current hotspot. 

# nmcli dev disconnect wlan0      // wlan0 is the Wi-Fi client interface 

7. Reconnect to the previously connected SSID. 

# nmcli dev conn wlan0 

8. Delete the connection. 

# nmcli connection delete <ssid> 
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Wi-Fi AP Mode  

To switch the device to Wi-Fi Access Point (AP) mode using the configuration 
file /etc/hostapd/wlan1.conf, follow these steps: 

• Start the Wi-Fi AP manually: 

# systemctl start hostapd@wlan1            // Wi-Fi AP interface          

• Enable automatic startup on boot: 

# systemctl enable hostapd@wlan1 

• Default Wi-Fi AP parameters in /etc/hostapd/wlan1.conf: 

SSID: agv-ap 

Password: 12345678 

 

4.2.3 Bluetooth 

Use the Bluetooth Manager to pair a Bluetooth device. 
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4.3 Peripheral Interfaces 

This section briefs on the functionality testing of the peripheral interfaces. You can refer 
to section 3.4 for the cable recommended for interfacing with the connector pins. 

4.3.1 RS485 

VT-AGV-3588J offers two RS485 ports mapped as /dev/ttyS1 and /dev/ttyS5, respectively. 

  

 

1. Use twisted-pair cables to wire the two RS485 ports (A0-A1, B0-B1). 

2. Open two separate terminals and set the baud rate for both ports. 

Terminal 1: # stty -F /dev/ttyS1 speed 115200 

Terminal 2: # stty -F /dev/ttyS5 speed 115200 

3. Transmit data in Terminal 1. 

# echo test > /dev/ttyS1 

4. Receive data in terminal 2. 

# cat  /dev/ttyS5 

5. The data received in Terminal 2 should be the same as those sent in Terminal 1. 
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4.3.2 RS232 

VT-AGV-3588J offers two RS232 ports mapped as /dev/ttyS0 and /dev/ttyS8, respectively. 

 

 

 

 

 

 

 

 

1. Use a straight-through cable to wire the TX and RX pins of an RS232 port (/dev/ttyS0 
for instance). 

2. Open a terminal and set the baud rate for the port. 

# stty -F /dev/ttyS0 speed 115200 

3. Transmit data. 

# echo test > /dev/ttyS0 

4. Receive data. 

# cat  /dev/ttyS0 

5. The data received should be the same as those sent in the prior step. 
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4.3.3 CAN 

VT-AGV-3588J offers two CAN buses, mapped as can0 and can1, respectively. 

  

 

1. Connect the two CAN buses (H-H, L-L, GND-GND). 

2. Open a terminal (Terminal 1) and bring up can0 with a bitrate of 500,000 bps: 

# ip link set can0 down 

# ip link set can0 up type can bitrate 500000 

# ip link set can0 up 

3. Open another terminal (Terminal 2) and bring up can1 with a bitrate of 500,000 bps: 

# ip link set can1 down 

# ip link set can1 up type can bitrate 500000 

# ip link set can1 up 

4. Use can0 to transmit data and can1to receive data. 

# cansend can0 123#1122334455667788         (Terminal 1) 

# candump can1                                                     (Terminal 2) 

5. The data received in Terminal 2 should be the same as those sent in Terminal 1. 
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4.3.4 USB 2.0 Host 

VT-AGV-3588J offers two USB 2.0 Host ports. You can connect a USB peripheral to either 
port to test the functionality of the port.  

 

 

 

 

 

 

 

 

 

 

1. List all connected USB devices. 

# lsusb 

2. After connecting a USB flash drive to the device, mount it to a specified directory (e.g., 
/mnt) using the device name identified in the prior step. 

# mount /dev/xxx /mnt 

3. Display the disk space usage of file systems. 

# df -h 

4. Check the mounted content. 

# ls /mnt 

5. Unmount the USB flash drive: 

# umount /dev/xxx 
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4.3.5 USB 3.0 Type-C 

VT-AGV-3588J offers a USB Type-C port, supporting USB OTG and DP alt mode for display 
output. To output images from the device, please use a USB Type-C to Type-C cable to 
connect the device and the monitor. 

4.3.6 User Button 

The button is user definable, and you can execute the following command to print the 
button log upon a press. 

# hexdump /dev/input/by-path/platform-gpio-keys-event-joystick  

 00000c0 9d93 6835 0000 0000 ddd3 0001 0000 0000 

 00000d0 0001 02c0 0001 0000 9d93 6835 0000 0000 

 00000e0 ddd3 0001 0000 0000 0000 0000 0000 0000 

 00000f0 9d93 6835 0000 0000 b288 0003 0000 0000 

 0000100 0001 02c0 0000 0000 9d93 6835 0000 0000 

 0000110 b288 0003 0000 0000 0000 0000 0000 0000 

 

4.4 Programming in CODESYS  

For VT-AGV-3588J running Ubuntu 22.04 with CODESYS Runtime, users can download and 
install the IDE (integrated development environment) package on the PC for device 
programming and control. 
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Prerequisites: 

• VT-AGV-3588J running Ubuntu 22.04 with CODESYS Runtime integrated 

• A Windows-based PC 

• VT-AGV-3588J and the PC are in the same subnet 

• Device description file and I/O description file 

4.4.1 IDE Download and Installation 

The following sections outlines the steps to use a Windows PC to connect VT-AGV-3588J 
for the purpose of programming and control.  

1. Download CODESYS Development System V3 (3.5.19 or later) from the official website 
of CODESYS: https://store.codesys.com/en/codesys.html.  

A user account is required for the first-time login. 

2. Follow the installation wizard to complete the installation of CODESYS IDE on the PC.  

 

 

4.4.2 Device and I/O Description Installation 

Before you start, make sure you have received the following files as part of the software 
release package: 

Device description file: /path/to/SW/codesys/Vantron-ARM_64-Linux-
SoftMotion.devdesc.xml) 

I/O description file: /path/to/SW/codesys/devdescIoDrvVantron.devdesc.xml 
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1. Install the device description: 

• Click Tools > Device Repository from the menu bar of CODESYS program. 

 

• Select the install location. System Repository is set by default. 

• Click the Install button to open the Install Device Description dialog. 

 

• Select the file path of the device description. 

• Select the file type filter of the required device description. 

• Select the device description file (Vantron-ARM_64-Linux-
SoftMotion.devdesc.xml) and click Open. 

• When the installation completes with success, the device will appear in the list of 
device descriptions in the middle of the window. 

2. Install the I/O description: 

• Repeat the operations in the prior step and select the I/O description file 

(devdescIoDrvVantron.devdesc.xml) for installation.  
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4.4.3 Project Creation and Device Connection 

1. In CODESYS, click File > New Project, and then the Projects category > Standard 
Project template.  

2. Specify a project name and its location in the file system, then click OK to save the 
settings. 

 

3. Select Vantron-ARM_64-Linux-SoftMotion as the device, then click OK.  The project is 
now created. 

4. Power on VT-AGV-3588J.  

5. Connect VT-AGV-3588J’s NET 1/NET 2 Ethernet port to a switch using an M12 X-coded 
(8-pin) male-to-RJ45 cable.  

6. Connect the PC to the same switch to make sure both devices are in the same subnet. 

Alternatively, to replace steps 5 and 6 you can: 

• Connect VT-AGV-3588J’s NET 0 directly to your PC's Ethernet port. 

• Configure a static IP address (e.g., 192.168.17.100/24) on the PC's Ethernet 
interface, ensuring it's in the same subnet as the device’s NET 0 
(192.168.17.253/24). 

7. In CODESYS, double click Device (Vantron-ARM_64-Linux-SoftMotion) under the new 
project. 

8. Go to Communication Settings > Scan network. 
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9. Select the device (linaro-alip xxx) from the list, and click OK. 

 

10. Create a device user if this is the first time you have added the device to the project. 
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11. Enter the username and password you created in the prior step for authentication. 

 

12. Allow the application to be created and downloaded. 

 

13. When VT-AGV-3588J  connects to the PC, both gateway and controller icons in 
CODESYS will be highlighted with a green dot, with details of the controller displayed. 
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4.4.4 Adding the I/O Module 

1. In CODESYS, right click Device (Vantron-ARM_64-Linux-SoftMotion) under the new 
project. 

 

2. Expand the Miscellaneous  menu and select IoDrvVantron. 

 

3. Click Add Device, and it will display under the current project. Click Close to exit. 

 

  

http://www.vantrontech.com/


Vantron| Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 

 Vantron  | Public                    43            www.vantrontech.com 

VT-AGV-3588J 
User Manual 

4.4.5 I/O Settings 

After enabling the I/O module upon a double click, you can configure the parameters for 
SSI under Internal Parameters menu. 

 

Under the Internal I/O Mapping menu, the AI, DI, AO, DO interfaces are displayed, where 
AI values are raw ADC readings, and AO values are raw DAC reading. 

 

System interfaces and the hardware ports are mapped as follows.  
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CODESYS Channel Signal Hardware Pin 

DIN0 
(digital input 0) 

Bit0 D_IN1 Pin 24 

Connector B 
 
 
 

(Input range:  
0-24V at 50mA) 

Bit1 D_IN2 Pin 25 

Bit2 D_IN3 Pin 26 

Bit3 D_IN4 Pin 27 

Bit4 D_IN5 Pin 15 

Bit5 D_IN6 Pin 14 

Bit6 D_IN7 Pin 4 

Bit7 D_IN8 Pin 3 

DIN1 
(digital input 1) 

Bit0 D_IN9 Pin 13 

Bit1 D_IN10 Pin 1 

Bit2 D_IN11 Pin 2 

Bit3 D_IN12 Pin 5 

 
 

CODESYS Channel Signal Hardware Pin 

VI1 AI_V0 Pin 33 Connector A  
(Input range: 0-24V) VI2 AI_V1 Pin 21 

AI1 AI_A0 Pin 22 Connector A  
(Input range: 0-20mA) AI2 AI_A1 Pin 34 

AO1 AO_OUT1 Pin 11 Connector A  
(Output range: 0-20mA) AO2 AO_OUT2 Pin 10 

SSI1 

DATA0- Pin 29 

Connector B 

DATA0+ Pin 28 

CLK0- Pin 30 

CLK0+ Pin 31 

SSI2 

DATA1- Pin 32 

DATA1+ Pin 33 

CLK1- Pin 18 

CLK1+ Pin 17 

PGND P_GND Pin 1 Connector A 
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CODESYS Channel Signal Hardware Pin 

DOUT1 
(digital output 1) 

Bit0 D_OUT1 Pin 24 

Connector B 
 
 

(Output range:  
0-24V at 0.5A) 

  

 

Bit1 D_OUT2 Pin 25 

Bit2 D_OUT3 Pin 26 

Bit3 D_OUT4 Pin 27 

Bit4 D_OUT5 Pin 15 

Bit5 D_OUT6 Pin 14 

Bit6 D_OUT7 Pin 4 

Bit7 D_OUT8 Pin 3 

DOUT2 
(digital output 2) 

Bit0 D_OUT9 Pin 13 

Bit1 D_OUT10 Pin 1 

Bit2 D_OUT11 Pin 2 

Bit3 D_OUT12 Pin 5 

 

 

CODESYS Channel Signal Hardware Pin 

DOUT3 
(digital output 3) 

Bit0 
ALL OK_CO Pin 12 

Connector A 
ALL OK_NO Pin 35 

 

Bit0 = True, ALL OK_CO and ALL OK_NO are shorted. 

Bit0 = False, ALL OK_CO and ALL OK_NO are not shorted. 
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4.4.6 Device Login 

After setting up the parameters: 

1. Click the login symbol (        )  to connect the application to the VT-AGV-3588J and 
starts the online mode. 

2. click the start icon (       ) to start the application. 

3. Select a mode for updating I/O variables on the lower right corner of the window. 

 

• Use parent device setting: Update according to the setting of the superordinate 
device. 

• Enabled 1 (use bus cycle task if not used in any task): CODESYS updates the I/O 
variables in the bus cycle task if they are not used in any other task. 

• Enabled 2 (always in bus cycle task): CODESYS updates all variables in each cycle 
of the bus cycle task, regardless of whether they are used and whether they are 
mapped to an input or output channel. 
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4.5 ROS 2 Humble Demo Test 

VT-AGV-3588J is pre-installed with required deb packages for ROS 2 Humble, including ros-
humble-desktop, python3-colcon-common-extensions, python3-colcon-core, ros-humble-
v4l2-camera, ros-humble-usb-cam, and ros-humble-image-pipeline. 

To run a demo test, follow these steps: 

1. Power on VT-AGV-3588J and open two terminals, terminal 1 (T1) for the publisher and 
terminal (T2) for the subscriber. 

2. Source the setup files in both terminals. 

source /opt/ros/humble/setup.bash 

3. In T1,  start the publisher. 

$ ros2 run demo_nodes_cpp talker 

# Expected output: 

[INFO] [1749065505.376454068] [talker]: Publishing: 'Hello World: 1' 

[INFO] [1749065506.376398235] [talker]: Publishing: 'Hello World: 2' 

[INFO] [1749065507.376399277] [talker]: Publishing: 'Hello World: 3' 

[INFO] [1749065508.376398569] [talker]: Publishing: 'Hello World: 4' 

4. In T2, start the subscriber. 

$ ros2 run demo_nodes_cpp listener 

# Expected output: 

[INFO] [1749065560.509145927] [listener]: I heard: [Hello World: 1] 

[INFO] [1749065561.509041094] [listener]: I heard: [Hello World: 2] 

[INFO] [1749065562.509033095] [listener]: I heard: [Hello World: 3] 

[INFO] [1749065563.509184345] [listener]: I heard: [Hello World: 4] 

 

For further guidance and advanced operations, refer to the official ROS 2 Humble 
documentation at https://docs.ros.org/en/humble/index.html.  
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CHAPTER 5 IMAGE FLASHING 
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5.1 Firmware Upgrade in Windows Environment 

Prerequisites:  

• A Windows host computer 

• VT-AGV-RK3588J AGV controller 

• A USB Type-A to Type-C cable 

• Software release package 

5.1.1 ADB setup on the Windows host 

Android Debug Bridge (ADB) is a tool that is designed to connect your development 
workstation directly to your Android device for debugging, device upgrading, app 
installation, etc. 

Adding the ADB executable file to the system’s environment variable allows you to run the 
ADB tool regardless of your current working directory. 

Follow the steps below to set up the ADB on the Windows host. 

1. Unzip the software release package and navigate to the following directory: 
\SW\downloadetools\windows. 

2. Extract the adbtoolswindows zip file. 

3. Navigate to the platform-tools folder that contains the ADB tool kit, and copy the folder 
path. 

4. Press “Win + R” and input sysdm.cpl in the dialogue box to open the settings interface. 
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5. Click in sequence Advanced > Environment Variables > System Variables > Path > Edit, 
and click New in the pop-up. 

 

6. Paste the path of the platform-tools folder, and click OK one by one to confirm and exit. 

 

 

 

 

 

 

 

 

 

 

7. Press “Win + R” and input cmd in the dialogue box. 

8. Input adb version in the command prompt to check if the ADB tool is installed. 
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5.1.2 Firmware upgrade  

1. Unzip the release package and open the directory of the upgrade driver (\SW 
\downloadetools\windows\DriverAssitant_vxxx); 

2. Right click the mouse and run the driver program DriverInstall.exe as administrator; 

3. Click Install Driver and wait for the installation to proceed; 

 

4. A pop-up will appear in a second suggesting the driver is installed; 

 

5. Open the directory of the upgrade tool (\SW\downloadetools\windows\ 
RKDevTool_Release_vxxx); 

6. Double click the driver for the upgrade tool RKDevTool.exe to open the upgrade 
window; 

 

7. Connect VT-AGC-3588J to the Windows host using a USB Type-A to Type-C cable; 
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8. Press “Win + R” and input cmd in the dialog box to open the command prompt;  

9. Input adb devices in the command prompt to check if the device is connected to the 
Windows host; 

10. Once the device is identified by the Windows host, input adb reboot loader to reboot 
the device into the bootloader mode; 

11. Then the upgrade window will prompt for the existence of a Loader device, indicating 
that the upgrade process is ready; 

 

12. Click Upgrade Firmware > Firmware in the upgrade window; 

13. Select the upgrade file (update.img) from the directory (\SW\Image) and click Open, 
and the firmware details will be automatically populated in the boxes; 

14. Click the Upgrade button and the device will start to download the image and upgrade 
the firmware automatically; 

 

15. When the upgrade finishes, the device will reboot automatically. 
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5.2 Firmware Upgrade in Ubuntu Environment 

Prerequisites:  

• A Ubuntu host computer 

• VT-AGV-RK3588J AGV controller 

• A USB Type-A to Type-C cable 

• Software release package 

 

1. Connect VT-AGC-3588J to an Ubuntu host computer using a USB Type-A to Type-C 
cable. 

2. Open a terminal on the Ubuntu host computer and input the following command to 
install the ADB tool if necessary. 

$ sudo apt-get install adb -y 

3. Check if the device is connected to the Ubuntu host computer via the ADB tool. 

$ adb devices -l 

4. Execute adb shell to access the device’s shell. 

5. Run reboot loader to reboot the device to the bootloader mode. 

6. Copy the release package to the Ubuntu host computer or save the release package 
to a USB flash drive and mount the USB drive to the Ubuntu system. 

7. On the Ubuntu host computer, open the directory where the upgrade tool (named as 
“upgrade_tool”) is located: \SW\downloadetools\linux\Linux_Upgrade_Tool_vxxx. 

8. Unzip the folder. 

9. Right click the mouse in an empty space of the folder and click Open in Terminal. 

10. Input the following command to start the upgrade process. 

$ sudo ./upgrade_tool uf xxx/update.img 

       “xxx” is the path of the image file (update.img), usually found in /SW/Image. 

11. The system will start upgrading after the download finishes, and it will reboot 
automatically when the upgrade finishes.  
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CHAPTER 6 DISPOSAL AND WARRANTY 
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6.1 Disposal 

When the device comes to end of life, you are suggested to properly dispose of the device 
for the sake of the environment and safety. 

Before you dispose of the device, please back up your data and erase it from the device. 

It is recommended that the device is disassembled prior to disposal in conformity with 
local regulations. Please ensure that the abandoned batteries are disposed of according 
to local regulations on waste disposal. Do not throw batteries into fire or put in common 
waste canister as they are explosive. Products or product packages labeled with the sign 
of “explosive” should not be disposed of like household waste but delivered to specialized 
electrical & electronic waste recycling/disposal center.  

Proper disposal of this sort of waste helps avoid harm and adverse effect upon 
surroundings and people’s health. Please contact local organizations or recycling/disposal 
center for more recycling/disposal methods of related products. 
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6.2 Warranty  

Product warranty 

VANTRON warrants to its CUSTOMER that the Product manufactured by VANTRON, or its 
subcontractors will conform strictly to the mutually agreed specifications and be free from 
defects in workmanship and materials (except that which is furnished by the CUSTOMER) 
upon shipment from VANTRON. VANTRON’s obligation under this warranty is limited to 
replacing or repairing at its option of the Product which shall, within 24 months after 
shipment, effective from invoice date, be returned to VANTRON’s factory with 
transportation fee paid by the CUSTOMER and which shall, after examination, be 
disclosed to VANTRON’s reasonable satisfaction to be thus defective. VANTRON shall bear 
the transportation fee for the shipment of the Product to the CUSTOMER. 

Out-of-Warranty Repair 

VANTRON will furnish the repair services for the Product which are out-of-warranty at 
VANTRON’s then-prevailing rates for such services. At customer’s request, VANTRON will 
provide components to the CUSTOMER for non-warranty repair. VANTRON will provide 
this service as long as the components are available in the market; and the CUSTOMER is 
requested to place a purchase order up front. Parts repaired will have an extended 
warranty of 3 months. 

Returned Products 

Any Product found to be defective and covered under warranty pursuant to Clause above, 
shall be returned to VANTRON only upon the CUSTOMER’s receipt of and with reference 
to a VANTRON supplied Returned Materials Authorization (RMA) number. VANTRON shall 
supply a RMA, when required within three (3) working days of request by the CUSTOMER. 
VANTRON shall submit a new invoice to the CUSTOMER upon shipping of the returned 
products to the CUSTOMER. Prior to the return of any products by the CUSTOMER due to 
rejection or warranty defect, the CUSTOMER shall afford VANTRON the opportunity to 
inspect such products at the CUSTOMER’s location and no Product so inspected shall be 
returned to VANTRON unless the cause for the rejection or defect is determined to be the 
responsibility of VANTRON. VANTRON shall in turn provide the CUSTOMER turnaround 
shipment on defective Product within fourteen (14) working days upon its receipt at 
VANTRON. If such turnaround cannot be provided by VANTRON due to causes beyond the 
control of VANTRON, VANTRON shall document such instances and notify the CUSTOMER 
immediately. 
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Appendix Regulatory Compliance Statement 

FCC Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

This device complies with Part 15 of FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) This device must 
accept any interference received, including interference that may cause undesired operation. 

Note: The manufacturer is not responsible for any radio or TV interference caused by 
unauthorized modifications to this equipment. Such modifications could void the user’s 
authority to operate this equipment. 

RF Radiation Exposure Statement: 

1. This equipment complies with FCC radiation exposure limits set forth for an uncontrolled 
environment. This equipment should be installed and operated with a minimum distance 
of 20cm between the radiator & your body. 

2. The device has been evaluated to meet general RF exposure requirement. 
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